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[bookmark: _Toc112164629][bookmark: _Toc114067116][bookmark: _Toc116553367]Purpose
This document provides guidance for preparing a Biological Assessment (BA) using the BA template (a separate document) created by DOE/EERE. While the BA template and this guidance document have been created to assist with the preparation of a BA, it is worth noting that both have been designed to focus on more common situations involving EERE financial assistance awards. Requirements and other items of concern for less common situations would be discussed as needed.
A BA is typically required when consulting with the National Marine Fisheries Service (NMFS) and/or the U.S. Fish and Wildlife Service (FWS), hereinafter collectively referred to as “the Services”, as directed under Section 7 of the Endangered Species Act (ESA). Consultation with the Services is required if DOE cannot justify a “no effect” determination for all federally listed species and critical habitats that may be affected by proposed activities of an award or other action (“project”). 
[bookmark: _Toc114067117][bookmark: _Toc116553368]Preparing a BA
DOE requires a thorough analysis of project effects on listed species and critical habitats in order to consult with the Services. A high-quality BA presents a clear and logical connection between all of its components and the conclusions reached. Review the entire BA template before you begin to write the BA to become familiar with its structure and information you will need.
The first draft of any BA will be sent to DOE for review. DOE will respond with feedback, edits, and requests for revisions. The BA will continue to be exchanged until a final draft of the BA is approved by DOE. Make sure “Track Changes” (“Review” tab) is active when you edit. Revised copies sent to DOE should include all tracked changes. This review process can be laborious for all involved, but a high-quality first draft can significantly reduce the time and effort required to produce a final draft. The BA template and this guidance document were designed to assist with the creation of high-quality first drafts.
[bookmark: _Toc114067118][bookmark: _Toc116553369]Quick Reference
This document has been formatted to assist with finding certain information quickly, including:Recommended language
(green box)
Definitions
(yellow box)
Tips or Examples
(blue box)

[bookmark: _Toc112164631]
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[bookmark: _Toc116553370]Acronyms

BA		biological assessment
BE		beneficial effect
BMP		best management practice
CC		content control
CM		conservation measure
CR		conservation recommendation
DOE		Department of Energy, U.S.
EERE		Energy Efficiency and Renewable Energy, Office of
EFH		Essential Fish Habitat
ESA		Endangered Species Act
FWS		Fish and Wildlife Service, U.S.
IPaC		Information for Planning and Consultation
LAA		likely to adversely affect
NE		no effect
NLAA		not likely to adversely affect
NMFS		National Marine Fisheries Service (a.k.a. NOAA Fisheries)
PDF		portable document format

[bookmark: _Instructions][bookmark: _Toc114067120][bookmark: _Toc116553371]Instructions
The BA template uses several Microsoft Word features to assist with making of a high-quality BA. These features are explained below. Some boilerplate language has been provided throughout BA template. It is recommended that you do not significantly change the boilerplate language. Boilerplate appears as “normal” text to avoid the need to adjust properties of the text.
[bookmark: _Toc112164632][bookmark: _Toc114067121][bookmark: _Toc116553372]Content Controls
Content controls (CCs), which are highlighted in yellow, are used throughout the template to help guide you with providing the relevant information in the right places. Simply click on the text of the CC and begin typing. The CC will be automatically removed when you start typing.
[bookmark: _Toc112164633][bookmark: _Toc114067122][bookmark: _Toc116553373]Text Styles
Aside from creating an organized, professional-looking document, using text styles for section headers enables you to use helpful navigation features in Word and quickly create a table of contents. Text typically defaults to the “normal” style, which is the correct style for the main text of your BA. To change the style of text:Which text style should I use?
The main body of the BA template already has numbered sections. The numbers are a hint to which text style headers are using:
  #.	à “Heading 1”
  #.#. 	à “Heading 2”
  #.#.#.	à “Heading 3”
The sections that are not numbered in the template use the “Heading 1” style.

1. Highlight the desired text,
2. Click on the “Home” tab at the top of the ribbon,
3. Find the “Styles” section of the ribbon,
4. Select the style you wish to use for the text.
One way to see if you are using the correct style for a header is to activate the “Navigation Pane” – which is in the “Show” section of the ribbon under the “View” tab. You will see the headers are tiered to their style in the navigation pane, similar to an outline.
[image: Graphical user interface, application

Description automatically generated]
Figure 1: screenshot showing "Styles" section of the ribbon under the "Home" tab.
[bookmark: _Toc114067123][bookmark: _Toc116553374][image: Graphical user interface, text, application

Description automatically generated]Captions
All images and tables in the BA should have a caption, but you won’t be able to update table and figure lists quickly and easily if you don’t add captions correctly. To add a caption:Figure 2: screenshot showing the "Insert Caption" and “Wrap Text” options from the drop-down menu (opened after right-clicking the image).

1. Right-click the image/table,
2. Click “Insert caption…”,
3. Modify as needed.
Keep in mind the layout settings of an image or table will affect the appearance of a caption and how it interacts with other text in the document. Hover over the image to see the “Layout Options” button appear next to the image (or right-click on the image à “Wrap Text”). Of the layout options, two are the best choices for a BA:
· “Square”: good for smaller images; caption is added to an adjustable text box.
· “In line with text”: good for images and tables that occupy the full width of the page.
[bookmark: _Reference_Tables][bookmark: _Toc112164635][bookmark: _Toc114067124][bookmark: _Toc116553375]Reference Tables
Reference tables include the table of contents, list of tables, and list of figures. Details regarding these features has been provided in the “Structure and Content of the BA” section of this guidance document (below).
[bookmark: _Toc112164637][bookmark: _Toc114067125][bookmark: _Toc116553376]Managing Sources
You can add your references/sources to a source manager in Word. To access the manager:
1. [image: Graphical user interface, application, Word

Description automatically generated]Click the “References” tab on top of the ribbon,Figure 3: screenshot showing the "Manage Sources" feature.

2. Find the “Citations & Bibliography” section of the ribbon, 
3. Click “Manage Sources”.
Adding your sources to the manger has numerous advantages, including 1) automatically generate and update your “References” section of the BA, 2) quick and easy additions of in-text citations, and 3) maintaining a collection of resources for future documents (e.g. BAs).
[bookmark: _Toc114067126][bookmark: _Toc116553377]Recommended Writing Order
· You may write the BA in whatever order you would like but the following order is recommended:
· Project Area, Action Area, Species & Habitats;
· Project Activities, Environmental Baseline;
· Effects of the Action, Conservation Measures;
· Conclusion;
· Background; 
· [bookmark: _Toc112164640]Executive Summary.
[bookmark: _Toc116553378]Review Process
[bookmark: _Toc114067127]The first draft of your BA must be sent to DOE for review. This initiates the internal review process which is iterative in nature: (1) DOE will review and provide feedback, (2) you will revise the BA, and (3) you will send DOE the revised BA for review. This cycle continues until DOE approves a final draft to use for consultation. The duration of the review process can be relatively short or long depending on the quality of the first draft, the complexity of the proposed project, and the potential effects to listed species and/or critical habitats. 
[bookmark: _Toc116553379]Common Mistakes
[bookmark: _Toc114067128][bookmark: _Toc116553380][bookmark: _Toc112164641]Would v. Will
Use “would” throughout this document to emphasize the conditional nature of the proposed project. Do not use “will”.
[bookmark: _Toc114067129][bookmark: _Toc116553381]Rushing the First Draft
Rushing the first draft of the BA is a common mistake, but it is also one of the more costly mistakes. It is understandable that you want to finish a draft so DOE may provide feedback, but high quality first drafts significantly reduce the overall time and effort required to prepare for and complete a consultation. 
[bookmark: _Toc114067130][bookmark: _Toc116553382][bookmark: _Toc112164642]Not Using Plain Language
It is important to write the BA in plain language, i.e. an educated layperson should be able to easily understand the BA. Most people we consult with in the Services are experts in areas of biology (or similar) and not the technologies/techniques you propose to use.
In short: avoid jargon when you can, provide supporting explanations as needed, and keep your sentences clear, simple, and focused. Doing so will help avoid a protracted consultation.
[bookmark: _Toc114067131][bookmark: _Toc116553383]Misplacing Content
The BA template provides the scaffolding for an orderly presentation of information in the BA. Do not stray from the purpose and focus of each section. Misplacing content can make it more difficult to the review the BA efficiently. Examples of misplacing content include:
· Discussing species details in the “Project Area” section,
· Discussing project effects on species in the “Project Activities” section or “Environmental Baseline” section, and
· Mentioning new project activity details in the “Effects of the Action” section.
[bookmark: _Toc114067132][bookmark: _Toc116553384]Poor Image Quality & Mislabeling Images
Maps and satellite images are essential for any high-quality BA, but an image of poor quality is hardly better than no image at all. Issues include poor resolution, microscopic fonts, mislabeled points of reference, and irrelevant information. Images need to be clear, easy to read, and relevant.
[bookmark: _Toc114067133][bookmark: _Toc116553385]Tables With Excessive White Space
Tables that are not formatted well or include excessive amounts of information that should not be in the table can result in lots of white space in the BA. Excessive white space typically coincides with reduced legibility. Tables should be concise, clear, and easy to read. If you can’t find a way to make a table easier to read, a table may not be the best choice for presenting the information.
[bookmark: _Toc112164645][bookmark: _Toc114067134][bookmark: _Toc116553386]Not Completing Final Checks
Some features in Word, while helpful and convenient, do not operate automatically. Before submitting the BA, make sure to do the following:
· Check the date on the cover page (recommended: wait to add until final draft is complete)
· Update all reference tables (table of contents, lists, references)
· Run spellcheck and check for typos
· Check accuracy of images, tables, and captions
[bookmark: _Toc114067135][bookmark: _Toc116553387]Inaccurate Species List
An inaccurate species list can result in unexpected delays during consultation with the Services and may affect the BA that was originally submitted for review. Getting an accurate species list is simple: get your list directly from the Services. For instructions on how to obtain a list from each Service, refer to the guidance listed under Section 3: Species & Habitats.
It is important to note that any potential listed species that receives a “no effect” determination must be a part of the species list in the BA and the determination must be documented. Additionally, protracted consultations may require updates to the initial species list due to changes to species and habitat listings that occur during consultation.
[bookmark: _Structure_and_Content][bookmark: _Toc112164646][bookmark: _Toc114067136][bookmark: _Toc116553388]Structure and Content of the BA
[bookmark: _Executive_Summary][bookmark: _Toc112164648][bookmark: _Toc114067138][bookmark: _Toc116553389]Executive Summary
This section should be a very brief, high-level overview of the BA. Briefly touch on key locations, activities, and participants. An educated layperson with no knowledge of the project, technologies, or the EERE award system should be able to easily understand this section. For the end of the summary, copy-paste your determinations summary from Section 6: Conclusions.
[bookmark: _Toc112164649][bookmark: _Toc114067139][bookmark: _Toc116553390][image: Graphical user interface, text, application

Description automatically generated]Contents (i.e. Table of Contents)
If you use text styles and lists correctly, you can easily update the BA table of contents. The table of contents does not update automatically. To update:
1. Click on the table of contents,
2. Click the “Update Table…” tab at the top of the table,
3. Select “Update entire table” button,Figure 4: screenshot showing location of “Update Table…” button.

4. Click “OK”.
[bookmark: _Toc112164650][bookmark: _Toc114067140][bookmark: _Toc116553391]List of Tables & List of Figures
If you add captions to all of your tables and figures throughout the BA, you can easily update these sections. These sections do not update automatically. To update:
1. [image: Graphical user interface, application

Description automatically generated]Select the “References” tab from the main ribbon at the top of the window,
2. Click the list you want to update,
3. Click “Update Table” from the “Captions” section of the ribbon, and
4. (Optional) Manually edit list of tables text without affecting the table caption.Figure 5: screenshot showing location of "Update Table..." button in the ribbon

[bookmark: _Toc112164651][bookmark: _Toc114067141][bookmark: _Toc116553392]Acronyms
[bookmark: _Toc112164652]You will need to update this list manually. Acronyms should be listed in alphabetical order. Remember to spell out all acronyms in full the first time you use them, starting from Section 1 (Background).
1. [bookmark: _Toc114067142][bookmark: _Toc116553393]Background
This section provides some basic context for the Services. Do not focus on project details.
1.1. [bookmark: _Toc112164653][bookmark: _Toc116553394]Proposed Project
Provide a very brief, high-level overview of the project’s background. This gives some context for the Services and emphasizes DOE’s involvement is funding the project, not completing the project. If applicable, briefly explain how the proposed project is part of a larger project (e.g. an award) and if any other federal entities besides DOE would be involved.
Reminder: this should focus on the background of the project, not details of the project itself.
1.2. [bookmark: _Toc112164654][bookmark: _Toc116553395]Consultation History
Provide an overview of past consultations relevant to the project. This may include consultations with other agencies for previous activities which are relevant to the project (e.g. acquiring a permit). This does not have to include consultations tied directly to the project described in the BA but may be related to a separate project with similar actions in the same area. If helpful, add relevant documents as appendices (e.g. a letter of concurrence, permit).
Do not delete this section if it is not applicable. Instead, the following language is recommended:
The proposed project does not have a consultation history to consider nor is there another project of a similar nature which could be considered relevant or informative for the purpose of this BA.

2. [bookmark: _Toc112164655][bookmark: _Toc114067143][bookmark: _Toc116553396]Project Description
This section must describe all activities and area(s) of the proposed project. This section should provide a detailed, deconstructed project description. The Services should be able to easily visualize and understand everything that would be happening at the proposed location(s).
2.1. [bookmark: _Toc112164656][bookmark: _Toc116553397]Project Area
Describe the project area(s) without getting into too much detail about human activities that occur in the area or the status of listed species (you will provide these details in Section 4: Environmental Baseline). Describe the locations where proposed project activities would occur, providing relevant details about the terrain, bodies of water, ecosystem, and human environment (e.g. structures, developments). Refer to Figure 6 and Figure 7 for additional details regarding the difference between “project area” and “action area”. 
This section should clearly define the project area(s). Maps and satellite images are critical components of a high-quality BA. While you are still expected to provide location details in the narrative format, this should be coupled with such images.
It may be appropriate to briefly mention specific project activities for context, but keep in mind that Section 2.3 (Project Activities) will cover activities in greater detail. Focus on describing the project area(s) and keep any description of activities at a very high level.
Project Area: area(s) where the core project activities would occur (a.k.a. project footprint).
Action Area: entire area which could potentially be affected, directly and indirectly, by project activities (e.g. noise, light, traffic).

[image: Diagram, map

Description automatically generated]
Figure 6: FWS diagram explaining “action area”. "Project footprint" in this case is equivalent to "project area".
2.2. [bookmark: _Toc116553398][bookmark: _Toc112164657][image: Diagram

Description automatically generated]Action Area
It is best to think of this as a continuation from the previous section, but it simply extends out to the action area. Like the previous section: describe the area, refrain from finer details regarding species, and add maps/images as needed. It may be necessary to mention project activities for context, but avoid going into too much detail.
Refrain from repeating long, detailed sections from the last section. Instead, reference the previous section as needed, e.g. “…similar to the project area…” or “…as described in the previous section…”.
Refer to Figure 6 and Figure 7 for additional details regarding the difference between “project area” and “action area”.Figure 7: Simplified, non-comprehensive diagram from NMFS illustrating relationship between "Project Area" and "Action Area".

2.3. [bookmark: _Project_Activities][bookmark: _Toc116553399]Project Activities
Describe all project activities that are relevant to the BA. It is very important that this section is detailed and comprehensive. Remember, the Services probably don’t know much or anything about this project, but they will want to know everything. The following should be very clear in this section:“Which activities are relevant?” 
Example: an award involves the design, fabrication, and field test of a mobile device. For the BA, field testing activities are relevant, but design activities are not. Fabrication activities are typically not relevant for EERE awards, but they may be relevant depending on scale, methods, and location.

· What activities would occur;
· How activities would be completed;
· Where activities would occur;
· When activities would occur;
· How long activities would take;
· Who would complete the activities;
· What instrumentation, equipment, vehicles, temporary structures would be involved; and
· What environmental disturbances (e.g. ground disturbances, tree removal) would occur (if any).
Do not describe activities that fall outside the scope of the proposed project described in the BA. If the proposed activities are part of a larger project (e.g. an award), that context should be provided at a high-level in the “Background” section of the BA. Site plans, test plans, or similar documents may be helpful and can be added as appendices and referenced as needed. 
Remember the purpose of this section is to describe what activities would occur, not their potential impacts (that is to be considered in the Section 5: Effects of the Project).
2.4. [bookmark: _Toc112164658][bookmark: _Toc116553400]Conservation Measures
Conservation measure (CM): an action to benefit or promote the recovery of listed species that are included as an integral part of the proposed action.

In other words, a conservation measure is anything that mitigates the effect of a stressor or reduces likelihood of exposure to a stressor. Similar terms: conservation recommendation (CR), best management practice (BMP).

Since species, habitats, and stressors have not been discussed at this point in the BA, avoid discussing finer details regarding species or stressors. High-level descriptions and generalizations are okay. It is recommended that the conservation measures are written in a way that are easily referenced since you may want to reference specific CMs later in the BA. 
The Services may recommend additional CMs during consultation. Such CMs are included in final consultation documents (e.g. letter of concurrence, biological opinion) issued by the Services. Proactive inclusion of CMs can help avoid delays during consultation.
It is not uncommon for project participants to have existing internal documents which include existing standard operating procedures which would qualify as conservation measures (e.g. vehicle operation speeds, stopping work when an endangered species is present). Such document(s) can be added as an appendix to the BA and summarized for this section.
Do not delete this section if it is not applicable. Instead, the following language is recommended:
As of the writing of this BA, the proposed project does not plan to implement any conservation measures (CMs). If deemed necessary, any CMs discussed and agreed upon with the Service(s) during consultation would be properly implemented.

3. [bookmark: _Species_&_Habitats][bookmark: _Toc112164659][bookmark: _Toc114067144][bookmark: _Toc116553401]Species & Habitats
The introduction of this section includes boilerplate in the form of a table – add rows as needed. Feel free to edit the table to organize the listed species into groups (e.g. birds, mammals), but do not delete or replace any existing columns.
This section focuses on identifying listed species, critical habitats, essential fish habitats (EFHs), or other species of concern which could potentially be affected by the proposed project. Focus on brief descriptions of what and where they are. Do not describe the status of any species or habitat. Do not describe project impacts on any species or habitat. 
Never assume that NMFS or FWS should not be consulted based on the action area or activities. All species and habitats of possible concern as identified by the Services must be addressed in the BA to a satisfactory degree. Refer to the “Obtaining a Species List” box below for additional guidance.
Obtaining a Species List
FWS: use the FWS’s IPaC website. IPaC is an effective tool that is relatively easy to use, but you can contact the respective regional FWS Ecological Services office if you need assistance or have questions.
NMFS: the best method is to contact the regional NMFS office (where the project would occur) and request a species list. While the NMFS website does have information on listed species and habitats, it can time consuming and challenging to create an accurate species list.


3.1. [bookmark: _Listed_Species][bookmark: _Toc112164660][bookmark: _Toc116553402]Listed Species
Add species subsections as needed using “Heading 3” style for headers.
Remember that you only need to focus on details that are relevant to the project. A comprehensive description of the species or habitats is not required and may result in a protracted consultation. Consider project stressors when determining what details are relevant. Relevant details may include:Examples
Stressor			Relevant Detail
Noise			Hearing range
Strike (boat)		Shallow water presence
Disturbance (benthic)	Benthic food sources

· life stages and/or life history,
· physiology and/or behaviors,
· habitat description,
· distribution and range, and
· other details concerning survival.
All potential species must be addressed in this section, even if a “no effect” (NE) determination is reached. If a NE determination is appropriate (e.g. not present due to seasonal migration), you may justify it in this section. Make sure to include language that accomplishes the following:
· clearly states an NE determination has been made,
· emphasizes the justification for the NE determination, and
· states that the species will not be discussed any further in the BA.
Important note: “not known to occur” is a flawed argument that should not be used when justifying a “no effect” determination for a species. “Not known to occur” may be a consequence of inadequate research or survey data, not because the species does not occur in the area.
A No Effect (NE) determination means there will be no consequences to the listed species or critical habitat that result from the proposed project, including the consequences of any activities that would not occur but for the proposed action.

Although an effect may be unlikely, this does not mean “NE” is reasonable. In most cases, NE determinations are reached because the species 1) would not be present in the project area (e.g. seasonal migration) or 2) there are no plausible routes of effects to the species.

3.2. [bookmark: _Toc112164661][bookmark: _Toc116553403]Critical Habitats
Critical habitats that may be affected, directly or indirectly, by the proposed project must be identified and described in this section. When identifying and describing these habitats, you may follow the general approach taken with Section 3.1: Listed Species. More information about critical habitats can be found on the FWS website and NMFS website.
If this section is not applicable, the following language is recommended:
The action area does not overlap with any critical habitats. Project activities would not indirectly affect critical habitats. Therefore, critical habitats will not be considered for the remainder of this BA.

3.3. [bookmark: _Toc112164662][bookmark: _Toc116553404]Essential Fish Habitats
While Essential Fish Habitats (EFHs) pertain to the Magnuson-Stevens Fishery Conservation and Management Act, not ESA, NMFS generally prefers that EFH considerations be a part of this BA to streamline consultation requirements. EFHs that may be affected, directly or indirectly, by the proposed project must be identified and described in this section. EFHs can be identified by using NMFS’s EFH Mapper. Additional information about EFHs can be found on the NMFS website.
Only delete this section if not consulting with NMFS. If this section is not applicable, but you are still consulting with NMFS, the following language is recommended:
The action area does not overlap with any Essential Fish Habitats (EFHs). Project activities would not indirectly affect EFHs. Therefore, EFHs will not be considered for the remainder of this BA.

3.4. [bookmark: _Toc112164663][bookmark: _Toc116553405]Other Species of Concern
Non-listed species protected by local, state, or other federal regulations (e.g. Marine Mammal Protection Act, Migratory Bird Treaty Act) may be present in the action area. These species should be acknowledged but not discussed in detail in the main body of the report. Instead, an appendix should be added to provide additional details.
Delete this section if it is not applicable. If this section is applicable, the following language is recommended:
Project activities have the potential to affect species which are not federally listed, but are protected by other regulations, including: [e.g. Marine Mammal Protection Act]. Being that such species are not federally listed species, they will not be discussed further in the main body of this report, but additional details can be found in [appendix].

4. [bookmark: _Environmental_Baseline][bookmark: _Toc112164664][bookmark: _Toc114067145][bookmark: _Toc116553406]Environmental Baseline
The section should briefly describe the environmental baseline of the action area, i.e. the “story” of the area (without the proposed project), which would include the current condition/status of listed species and habitats of concern. This section should not address the proposed project or analyze if the project would affect the area, species, or activities. Details should include:
· human activities which potentially affect listed species and/or habitats,
· natural events potentially affecting species or habitats,
· abundance of listed species,
· population trends of listed species, and
· condition of habitats.
Reminder: this section should not introduce new information about the project area, action area, species, or habitats. If you feel that new information must be introduced in this section, that is a sign that a previous section may be incomplete.
4.1. [bookmark: _Toc112164665][bookmark: _Toc116553407]Past and Current Activities Within Area
Briefly describe human and natural activities that occur in the project’s action area. This section does not have to be comprehensive or extremely detailed but should be sufficiently informative for the purpose of the BA. 
4.2. [bookmark: _Toc112164666][bookmark: _Toc116553408]Status of Listed Species
Briefly describe the status of listed species in the action area, but do not address potential project impacts. If needed, add subsections using the “Heading 3” text style for the header. You do not need to address species that received a NE determination in the previous section (Section 3: Species & Habitats).
4.3. [bookmark: _Toc112164667][bookmark: _Toc116553409]Status of Critical Habitats
Briefly describe the status of critical habitats in the action area, but do not discuss potential project impacts. If needed, add subsections using the “Heading 3” text style for the header. Delete this section if it is not applicable.
4.4. [bookmark: _Toc112164668][bookmark: _Toc116553410]Status of Essential Fish Habitats
Briefly describe the status of EFHs in the action area, but do not discuss potential project impacts. If needed, add subsections using the “Heading 3” text style for the header. Delete this section if it is not applicable.
5. [bookmark: _Effects_of_the][bookmark: _Toc112164669][bookmark: _Toc114067146][bookmark: _Toc116553411]Effects of the Project
This section should be a clear, comprehensive analysis of the direct, indirect, and cumulative effects of the proposed project on listed species and/or habitats previously identified in the BA. Effects from interrelated and interdependent actions should also be considered. This section should start with a summary that introduces the stressors that will be discussed. Interrelated activity: activities that are part of a larger action and depend on the larger action for their justification.
Interdependent activity: activities that have no significant independent utility apart from the proposed activities.
Direct effect: a consequence resulting from stressors produced from project activities.
Indirect effect: a consequence resulting from direct effects of project activities (typically occur later in time and may even occur outside the action area).
Cumulative effect*: the additive effect of “reasonably certain to occur” future state, private, and tribal activities.

*ESA definition (i.e. does not include foreseeable future federal actions), not the NEPA definition (which considers foreseeable future federal actions).

This is the most important section of the BA as it will include the analyses which justify effect determinations. Considering this section requires thorough and thoughtful analyses, this section is expected to be detailed and one of the longer sections of the BA. This section should have clear connections to previous sections.
5.1. [bookmark: _Toc116553412]Stressor
Do not use “stressor” as the header title. In the template, enter the first stressor name using the content control and add additional stressors as needed using the “Heading 2” text style for each header. The examples provided (below) do not represent a comprehensive list of stressors.
5.1.1. Description
Describe the stressor, including its source(s) and measurable characteristics. Do not discuss the potential effects. The following factors should be considered for every stressor: 
1. proximity,
2. distribution,Stressor Examples
Noise		Electromagnetic fields
Collision	Ground disturbance
Light		Vegetation removal
Smoke		Dust

3. duration,
4. frequency,
5. intensity,
6. severity,
7. timing, and
8. nature of the effect.
5.1.2. Potential Effects
Describe the potential effects the stressor may have on species and habitats. Potential effects can impact physical, chemical, and biological components of the land, air, and water of the action area. Potential effects should have clear connections to the stressor description (previous subsection) and species/habitat descriptions (Section 3: Species & Habitats). Stressor effects must be analyzed to determine if they are discountable, insignificant, or beneficial.
Discountable: stressor exposure/occurrence extremely unlikely to occur
Insignificant: effects from the stressor would have a negligible or immeasurable impact
Beneficial: effects from the stressor benefits the species/habitat with no adverse impacts

End every “potential effects” subsection with a clear, concise statement which describes the effects of the stressor using the terms (1) “beneficial”, “insignificant”, and/or “discountable” and (2) which species/habitats it applies to (because an effect that may be discountable for one species may not be discountable for another). You do not have to list each species individually, but all species (that did not receive a “no effect” determination in Section 3: Species & Habitats) must clearly be accounted for.
If adverse effects are unlikely and/or negligible:
· Describe as “…discountable…” and/or “…insignificant…”
· Do not describe as “…not beneficial…”
If adverse effects are likely or significant:
· Describe as “…not discountable…” and/or “…not insignificant…”
· Do not describe as “…not beneficial…”
If effects are only beneficial:
· Describe as “…wholly beneficial…”
· Do not describe as “…discountable…” and/or “…insignificant…”
· Do not describe as “…not discountable…” and/or “…not insignificant…”

Your analyses and findings must be objective, logical, and reasonable. In addition to the “not known to occur” argument mentioned earlier (3.1. Listed Species), the following types of arguments should not be used:
· “Net positive”, i.e. the sum of effects is considered beneficial to the species; 
· “Displacement”, i.e. the species can move away from the action area; or
· “Deal with it later”, i.e. a promise to create then follow conservation measures only if a listed species is encountered during project activities. 






6. [bookmark: _Conclusions][bookmark: _Toc112164674][bookmark: _Toc114067147][bookmark: _Toc116553413]Conclusions
This section should briefly summarize the determinations for all species and habitats (copy-paste the summary to the end of the Executive Summary). Do not reiterate stressor details from the previous section (5. Effects of the Project). Two examples for summary statements have been provided below, but do not represent all possible scenarios. If applicable, add details to address EFHs.
Example 1: Adverse effects unlikely for species, but no critical habitats in the action area.
Considering the analyses documented in this BA, it has been determined that (1) all federally listed species the proposed project may affect are not likely to be adversely affected and (2) the project would have no effect on critical habitats since there are no critical habitats within the action area.

Example 2: Adverse effects likely for species and critical habits.
Considering the analyses documented in this BA, it has been determined that the proposed project (1) would likely adversely affect (LAA) at least one federally listed species and (2) would result in the destruction or adverse modification of federally designated critical habitats.

6.1. [bookmark: _Toc116553414]Effect Determinations for Species
This subsection must document effect determinations for all species mentioned at the beginning of Section 3: Species & Habitats of the BA – which includes species with “no effect” determinations. The simplest method is to use a table. The first row of a table has been provided in the BA template, but you can add as many rows as needed. All determinations must be objective, reasonable, and consistent with analyses in Section 5: Effects of the Project.
Use the following acronyms for species effect determinations:
NE (no effect)
· Effects from all stressors will not affect the species.
NLAA (may affect, but not likely to adversely affect)
· All effects from stressors are insignificant, discountable, or beneficial.
LAA (may affect, likely to adversely affect)
· At least one effect from a stressor is not insignificant or not discountable.
BE (may affect, wholly beneficial effect)
· All effects from stressors are beneficial without adverse effects.


6.2. [bookmark: _Toc116553415]Effect Determinations for Habitats
This subsection must document effect determinations for all critical habitats (and Essential Fish Habitats) mentioned at the beginning of Section 3: Species & Habitats. Like the species table (mentioned above), add rows to the table in the template as needed. All determinations must be objective, reasonable, and consistent with analyses in Section 5: Effects of the Action.
Use the following language for habitat determinations:
“No destruction or adverse modification”
· The project will not result in a direct or indirect alteration that diminishes the value of critical habitat for the survival and recovery of the species.
“Destruction or adverse modification”
· The project will result in a direct or indirect alteration that diminishes the value of critical habitat for the survival and recovery of the species.

If there are no critical habitats (or EFHs) in the action area, delete the table and add the following recommended language:
The action area of the project does not overlap with any federally designated critical habitats; therefore, the project would have no effect on such habitats.

[bookmark: _Toc112164675][bookmark: _Toc114067148][bookmark: _Toc116553416]References
This section does not update automatically. To update this section:
1. click the “References” header, then
2. click “Update Citations and Bibliography”.
Reminder: sources will not populate in the section if they are not in source manager. Refer to “References Tables” subsection of the “Instructions” section of this document for additional details regarding the source manager.
[bookmark: _Toc112164676][bookmark: _Toc114067149][bookmark: _Toc116553417]Appendices
Appendices can include any detailed content or reference documents that may be valuable and relevant to the consultation but would otherwise disrupt the orderly presentation of information in the main body of the BA. Delete the example cover page from the template if it is not applicable.
Add appendices as needed. Each appendix should use the “Heading 1” style for the header. Appendix headers are added as a separate page to make it easier to insert appendix content that is in a different format, e.g. a PDF file. Inserting documents may occur after the final BA is converted to a PDF file – make sure reviewers from DOE are aware and send the content separately during the review process.
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